
 

Amicus Attorney: Document Assembly Notes 
This document is intended for firms who are upgrading from an earlier version of 
Amicus Attorney to Amicus Attorney V+ or Small Firm Edition. It also provides 
instructions for firms upgrading to a higher version of HotDocs. 

In the case of an Amicus Attorney update, the installation program copies and updates 
files and converts your existing macros and Master Document templates. Part of this 
process is performed by the Updater Macro, which, if necessary, you can run after the 
installation. This document explains these tasks and provides further details on how to 
preserve any customized macros.  

Supported third-party applications 
During the installation of Amicus Attorney V+ or Small Firm Edition, you are prompted to 
choose your word processor(s) and indicate whether you use HotDocs. Sample versions of 
Master Documents will be installed based on this selection. 

The following table shows the various word processors and document assembly 
applications supported in Amicus Attorney Version V+ or Small Firm Edition. In addition, 
any limitations relating to particular versions are noted. 

Note: Amicus Attorney V+ is available in three editions: Organizer, Advanced, and 
Client/Server. All three editions offer support for the applications listed in the following 
table.  

Application Name 
and Version  

Limitations and/or Issues  

Corel WordPerfect 8, 
9, 10, 11, 12, 13 (X3) 

The AutoMerge feature will not work if WordPerfect is running. 

Latest Corel WordPerfect Service Pack is required. 

Microsoft Word 2000, 
2002, 2003, 2007 

Ensure that Macro Security Settings are set to Medium or Low. 

Latest Microsoft Office Service Pack is required. 

There are some compatibility issues with Word 2007 under Windows Vista. 
For details, see the Windows Vista Compatibility Statement available from 
the Support > Technical Resource Guides page on our website.  

HotDocs 5.3 or 
higher, 6.1 or higher, 
2005, 2006, 2007 

For HotDocs support of versions of Corel WordPerfect and Microsoft Word, 
we recommend that you check with LexisNexis. For example, HotDocs 6 
requires either WordPerfect 9 or higher or Word 2000 or higher. 

The HotDocs 6.2 toolbar in Master Documents includes new buttons that 
are not functional in HotDocs 6.1. 

In HotDocs 2005 (and higher) Word Master Documents, the Next Field and 
Previous Field buttons on the HotDocs Navigation toolbar do not work. 
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What happens on upgrade to Amicus Attorney V+ or Small 
Firm Edition from Version IV or earlier? 

If you are upgrading from a previous version of Amicus Attorney to Amicus Attorney V+ or 
Small Firm Edition , the installer will check for your previous version of Amicus Attorney. It 
will then perform the following tasks: 

The existing Master Document templates are copied as follows: 

Advanced and Client/Server Edition users: 
• From the old server Template\Document folder 

(e.g. [drive]:\TEAM#\Template\Document) 

• To the new Template\Document folder 
(e.g. [drive]:\TEAM50\Template\Document) 

Organizer Edition users: 
• From the old standalone Template\Document folder 

(e.g. [drive]:\AMICUS#\Template\Document)  

• To the new Template\Document folder 
(e.g. [drive]:\AMICUS50\Template\Document) 

Small Firm Edition users: 
• From the old standalone Template\Document folder 

(e.g. [drive]:\TEAM#\Template\Document or 
[drive]:\AMICUS#\Template\Document)  

• To the new Template\Document folder 
(e.g. [drive]:\AMICUS TEAM SF\Template\Document) 

The standard MAP file depending on your word processor (WP.MAP for WordPerfect and 
WORD.MAP for Word) is updated to include the new fields available for document 
assembly, if necessary. 

Your word processor will be launched to run the appropriate Updater Macro to 
convert existing macros and/or Master Document templates, only if the required word 
processor is installed on the Server. If you do not have the required word processor on 
the Server, you can run the Updater Macro later. (See the next section for information 
on running the Updater Macro after install.) The Updater Macro is called only during 
the installation of Amicus Administrator on the Server. 

Note: Your existing Master Document templates on the server are copied—not moved—
from your previous version.  

Following is a brief description of install routines specific to Microsoft Word and Corel 
WordPerfect, as well as the Updater Macro routines that run for each. 

Corel WordPerfect 

When you are installing a Team Member in the Amicus Attorney V+ Advanced or 
Client/Server Edition or the Amicus Attorney Small Firm Edition, or when you are installing 
the Amicus Attorney V+ Organizer Edition, the AMIMERGE folder is backed up to a folder 
named OLDAMIMERGE, and then the following macro files are copied to the AMIMERGE folder:  

• AABRAD.WCM 
• AAFIELD.WCM 
• AAWPMERG.WCM 
• AAWPTLBR.WCM 
• X001.WCM 
• x002.WCM 
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In addition, the AAWP.WPT template will be updated. These macros overwrite existing 
macros of the same name in the AMIMERGE folder. They contain new routines and 
enhancements, such as improved Save to Brad functionality and new fields. 

Note to those upgrading from Amicus Attorney Version III or lower to Version 
V+ or Small Firm Edition: If you chose WordPerfect as your word processor during the 
upgrade from Version III to V+ or Small Firm Edition, the installer will automatically run 
the AAUPDATER.WCM macro provided it finds WordPerfect installed on the Server. This 
macro will proceed to look into each existing WordPerfect Master Document template 
(excluding WordPerfect HotDocs templates) and renumber any of the Extended Party Field 
variables to a higher Field number. This was necessary to accommodate the increase in 
the number of custom fields. For example, Extended Party variable Field #241 will be 
renumbered Field #333. For this reason it is important that the Master Document 
templates use the updated WP.MAP file to ensure field consistent mappings. 

Note about existing HotDocs WordPerfect Master Documents: It is not necessary to 
convert WordPerfect HotDocs templates because the Extended Party Fields are handled 
differently, and the Save To Brad functionality will be called from the new AABRAD.WCM 
macro. However, new Amicus Attorney fields will NOT be available in existing HotDocs 
templates, as HotDocs Component files were unable to be updated. The new fields will be 
available in new HotDocs templates created after the update. 

Microsoft Word 

If you are upgrading from Amicus Attorney 5.0.x or an earlier version to Version V+ or 
Small Firm Edition , the installer will instruct you on running the Updater Macro, 
AAUPDATER.DOT. The Updater Macro will convert all of your existing Word Master 
Document templates, but does not affect HotDocs Word master documents.  

If you chose NOT to run the updater at the time of your installation, or were unable to do 
so because your word processor was not installed on your server, please consult the 
WORDREADME.TXT file. This file is located in the TEAM50 folder on your Server if you are 
using the Advanced Edition or Client/Server Edition, or in AMICUS50 folder if you are using 
the Organizer Edition. 

The following macros will be updated: AmicusMerge and AmicusMergeFields.  

The following new macros will be added: AAFields, AAMerge, and AASavetoBrad.  

If you have any existing Word Master Document templates that contained customized 
versions of these macros, you should test these documents to see whether they are 
affected. (See the later section on custom issues.) 

Note about existing HotDocs Word Master Documents: It was not necessary to 
convert HotDocs Word templates because the Save To Brad functionality is called from 
SAVETOBRAD.DOT in the Word global templates folder. However, new Amicus Attorney fields 
will NOT be available in existing HotDocs templates, as HotDocs Component files were 
unable to be updated. 



Amicus Attorney : Document Assembly Notes (April 2007) © 2007 Gavel & Gown Software Inc. 4 

1 
2 
3 
4 
5 

6 

1 
2 
3 
4 

5 
6 

Running the Updater Macro later (if necessary) 
If you chose not to run the Updater Macro at the time of upgrading to Amicus Attorney V+ 
or Small Firm Edition from Release 5.0.x or an earlier version, or were unable to do so 
because your word processor was not installed on your server, you can run it later, after 
the installation/upgrade.  

First, if you are an Advanced or Client/Server Edition user, ensure that no Team Members 
are creating or generating Master Documents.  

Second, run the macro on the workstation of an installed Amicus Attorney Team Member 
who has the appropriate word processor installed.  

Note: The length of time it takes to run the macro depends on the number of Master 
Documents that need to be updated. Once you have run the macro, there is no need to 
run it again.  

To run the Updater Macro, complete the following instructions for the word processor you 
are using. 

Corel WordPerfect 

Advanced, Client/Server, and Small Firm Edition users: 
Ensure that no Team Members are working with any master documents. 
Start WordPerfect.  
Open the Tools menu and choose Macro, then choose Play. 
From the 'Look in' drop-down list, choose the Amicus Attorney file server. 
Open either the TEAM50 folder (if Advanced or Client/Server) or the AMICUS TEAM SF 
folder (if Small Firm), and select AAUPDATER.WCM. 
Click Play. 

Organizer Edition users: 
You do not need to run the Updater Macro. 

Microsoft Word 

Make sure that no Team Members are working with any master documents. 
Start Microsoft Word. 
Open the File menu and choose Open. 
Open the TEAM50 folder (if Advanced or Client/Server), the AMICUS50 folder (if 

Organizer), or the AMICUS TEAM SF folder (if Small Firm), and then select the 
AAUPDATER.DOT document template. 
Click Open. 
Follow the instructions in the AAUPDATER.DOT template. 

The AAUPDATER.DOT template also contains some troubleshooting tips for some common 
errors that you may or may not experience depending upon the version of Word your 
templates were created in and your current version of Word. 
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Conversion issues for customized macros 
If your existing Master Documents contained extensive customization that may have been 
affected by the conversion routines described earlier, it may be more efficient to copy 
those existing templates back from the Template folder of your previous version. 

Corel WordPerfect 

Please note that we do NOT recommend that you overwrite the new Amicus Attorney 
.WCM files because this will cause unexpected results. You should ensure that any 
customized macros are still accessible to those Master Documents requiring such macros.  

Microsoft Word 

Because Word Master Documents each hold the macros necessary to run that individual 
template, it may be advisable to copy those existing Master Documents back, depending 
on the complexity of any customized macros they may contain. As noted earlier, the 
previous versions of your Master Document templates still exist under your old Amicus 
Attorney version folder in the “TeamX\Template\Document” folder on your Server.  

For those upgrading from Version III or earlier to Version V+ or Small Firm 
Edition : Old Word templates that you do not convert will still run, but some routines will 
no longer work including the following ones:  

• The Save To Brad routines will not work because they are looking for the AA32.ini file 
rather than the Aa50.ini file.  

If you wish to manually update this routine so that it will still run the old Save To Brad 
functionality, go into the macro AmicusMerge and search for the following line: 

WordBasic.SetPrivateProfileString “Add Doc To File Brad”, “File”, 
DocumentName$, “aa32.ini”  

The line above should be replaced with the line below: 

WordBasic.SetPrivateProfileString “Add Doc To File Brad”, “File”, 
DocumentName$, “aa50.ini” 

• New fields (i.e. new custom fields) will not be available to the template. Adding this 
functionality manually is more complex than the items above, but if you are familiar 
with writing macros, then refer to the AAFIELDS macro in the AMICUS.DOT template. 

Map Files in Amicus Attorney V+ and Small Firm Edition  

The new default MAP files (WORD.MAP and WP.MAP) that reside in the Template\Document 
folder on the Server are backward compatible with previous variables, including custom 
fields. Existing WordPerfect templates that contain Extended Party Fields will be 
compatible with the new WP.MAP file, provided those existing templates were converted as 
noted earlier. 
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HotDocs Master Documents 

Sample Master Documents 

Amicus Attorney Small Firm Edition 

If you indicated that you are a HotDocs user during the installation/update of Amicus 
Attorney V+, sample HotDocs 6 Master Documents will have been installed. 

Amicus Attorney V+ 

If you indicated that you are a HotDocs user during the installation/update of Amicus 
Attorney V+, sample HotDocs 5 Master Documents will have been installed. 

If the sample Master Documents (or your own Master Documents) do not match your 
current version of HotDocs, you may need to complete some additional steps as outlined 
below. For example, there were major changes made to the HotDocs document structure 
between HotDocs 5 and 6. The HotDocs 6 Master Documents are compatible for use with 
HotDocs 6.2 and higher, while the HotDocs 5 Master Documents are not. 

Sample HotDocs 6 Master Documents are available for Amicus Attorney V+.  

• To use them in Amicus Attorney V+, copy them from the ...\TEAM50\Extras\HotDocs 
6\Word and/or ...\TEAM50\Extras\HotDocs 6\WordPerfect folders to the 
...\TEAM50\Template\Document folder. 

• To use them in Amicus Attorney Small Firm Edition, copy them from the ...\AMICUS 
TEAM SF\Extras\HotDocs 6\Word and/or ...\AMICUS TEAM SF\Extras\HotDocs 
6\WordPerfect folders to the ...\AMICUS TEAM SF\Template\Document folder. 

CAUTION: These HotDocs 6 Master Document files will overwrite HotDocs 5 Master 
Documents with the same name. 

Upgrading HotDocs 5 or earlier Master Documents 

A. Remove existing Word macros 

(This step is NOT necessary for HotDocs WordPerfect Master Documents.) 
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Ensure that no Team Members are using any HotDocs Word Master Documents in 
either Amicus Attorney or HotDocs.  

Complete the following steps at a workstation or server on which Amicus Attorney V+ 
or Small Firm Edition, HotDocs 6 or higher, and your earlier version of HotDocs are 
installed,  

If you are using Word 2000 or higher, ensure that Word’s macro security level is set to 
either Medium or Low.  

Ensure that your previous version of HotDocs is running 

Launch Word. 

Choose File > Open and open AAHD6UPDATER.DOT. In Amicus Attorney V+, this file is 
located in the ...\TEAM50\Extras\Hotdocs 6 folder. In Amicus Attorney Small Firm 
Edition, this file is located in the ...\AMICUS TEAM SF\Extras\Hotdocs 6 folder. 

Follow the instructions on the screen. This process will remove the old macros from the 
firm’s Amicus Attorney HotDocs Word Master Documents created in earlier versions of 
HotDocs. 



B. Convert Master Documents 

In HotDocs 6 or higher, create a new Library. From Windows Explorer, drag and drop your 
HotDocs 5 or earlier Word and WordPerfect Master Documents into the new HotDocs 
Library. In HotDocs 6 or higher, open them for editing, and then save them. This 
completes their conversion. For more information, see the documentation that came with 
your HotDocs program. 

Using HotDocs 2005 or higher 

If your firm now uses HotDocs 2005 or higher, users may continue to generate 
documents from HotDocs 6 Master Documents. Any Master Documents edited will be 
automatically converted to your current version of HotDocs. 

We recommend that you convert the blank Amicus HotDocs 6 Master Documents to your 
current version of HotDocs. These blank Master Documents are utilized whenever HotDocs 
Master Documents are created in Amicus Attorney.  

The blank Master Documents are HD6WORD.DOT and hd6wp.wpt. In Amicus Attorney V+, 
these files are located in the …\TEAM50\Template\Sysdoc folder. In Amicus Attorney Small 
Firm Edition, these files are located in the ...\AMICUS TEAM SF\Template\Sysdoc folder.To 
convert them, create a new Library in your current version of HotDocs. From Windows 
Explorer, drag and drop them into the new HotDocs Library. In HotDocs, open them for 
editing, and then save them. This completes their conversion. For more information, see 
the documentation that came with your HotDocs program. 

 

 

 

 

For further information, contact 

  

Gavel & Gown Software Inc. 
365 Bay Street, Suite 700 
Toronto, Ontario M5H 2V1 
Phone: 800-472-2289 
 416-977-6633 
Fax: 416-977-2563 
www.amicusattorney.com 
info@amicusattorney.com
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